
Psych Advantage
Version 12.7 Service Pack Enhancements 

(Includes Multiple Service Packs) 
Document Revised (12/29/2023)

Items listed on this document are the Service Pack Enhancements released with incremental 
updates between version steps (e.g. V12.7 To V12.8).

Enhancements are presented from newest to oldest within each section.

To the left of each enhancement is the Service Pack that it is available in.  Example: 12.7.0.26 
means that the enhancement is available in that version build and GREATER.

The current version in distribution is 12.7.0.26.  Enhancements with a Service Pack number 
GREATER than this are in BETA, and will be available soon.  Look for BV in the left margin to see 
what is coming.  You can also search for the entries with BV by using the keyboard shortcut CTRL-F, 
entering BV, then selecting the Previous/Next buttons to move between them.

The "KNOW BEFORE YOU GO" section includes important items for your office to review PRIOR 
TO UPDATING to this new version.  Look for screen, table and other changes that might affect your
workflow.   X  Items with a red X are additional important items.

Items marked (Request) were requested by clients and satisfied in the associated update.

Click here to access enhancement details for Documents, EHR Screens and Smart Functions. This 
Content Catalog is evolving, covering changes since Version 12.2, and is updated frequently.

Visit the Education Page for Psych on the Compulink Client website for additional resources.

For any questions or comments regarding this documentation, please email the Documentation 
department at: documentation@compulinkadvantage.com

The topics in the Table of Contents contain links; click a topic to jump to that spot in the document. 
Click on the red page number at the bottom right of the page to return. 
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Hot Topics
 X (7/28/2023)(12.7.0.24) Help > Knowledge Base Search

• A new Knowledge Base Search option was added to allow users to search Compulink’s 
   internal KB of “How To” items.
• From any screen with the Help icon, click Help and select Knowledge Base Search.
• The following prompt displays: Enter Keywords Separated by Spaces
• Enter your keywords to search for and click ‘OK’. 
          • Example: PERFORMED
• A small blue window flashes displaying: Searching Compulink Knowledge Base…..
• Results not found:
          • The following message displays if no results are found: Unable to find any matches
             to your Keywords at this time! The Knowledge Base is growing daily, so please 
             check back again soon!
• Results found:
          • If results are found, the ‘Select Knowledge Base Item to View Solution’ window 
             opens with a list of items that matched.
                    • Information displayed: Description and Modified date.
          • Double click on an item to open the ‘Advantage Education’ window.
                    • Subject – The Keywords that were searched
                    • First panel – Description of the KB
                    • Second panel – KB “How To” information to follow
          • Cancel and Save icons:
                    • Click the ‘Cancel’ icon to close the KB window and go back to the search 
                       results.
                    • Click ‘Save’ to close both the KB window and the search results and go back
                       to the Advantage software.

 X (6/13/2023)(12.7.0.23) General > Data Entry > Right Click Save

• Many areas of the software now have the option to right click to save data. (Request) 
• This was added to reduce mouse movement and speed up documentation.
• Windows where this functionality is available are identified by the new ‘Save/RC’ icon.
          • You must right click either in an empty space on the panel or the toolbar (avoiding 
             icons).
          • Right clicking in a field gives other options.
• Examples:
          • Patient – Edit a patient record in the PopUp and right click in an empty space on 
             the panel to save (make sure you are on the panel and not in a field).
          • Exam – Encounter Favorites window, select then right click in empty space.
          • Ledger – Entering a charge, right click in an empty space to save.
***With the addition of this feature in the patient Exam, you must use a left click in the 
panel to bring up the list of commands such as View Encounter Favorite, Assign Normal 
Values, Forward from Selected Visit, etc.

 X (7/7/2023)(12.7.0.24) General > Data Entry > Right Click Save
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• If the user continues to use the legacy Save icon, they receive the following reminder: 
   Use Mouse Right Click to Demonstrate Efficiency of Saving Changes VERY QUICKLY!
          • Once a week after using the legacy save 5 times the reminder pops up.
• The following message also displays upon exit of the Advantage software (distance 
   calculated per Login): The Screen Cursor has Moved an estimated X MORE FEET by NOT 
   using Right Click Quick Save! Are you SURE you want to Exit ADVANTAGE Software?

 X (6/13/2023)(12.7.0.24) Patient > Portal > Updates

• The following updates were made to the Patient Portal as of 5/26/23:
          • Home icon
                    • A new Home (house) icon was added to right side of the top bar.
                    • From any other area of the portal, click the Home icon to return to the 
                       home page.
          • Patient information
                    • The patient name and Location display at the top right.
          • Appointments button
                    • This is a new button added to display any upcoming Appointments.
                    • Information displayed includes:
                              • Provider Appointment is scheduled with
                              • Location where Appointment is scheduled
                              • Appointment Date
                              • Appointment Time
                              • Appointment Reason
                    • Click ‘Show Past Appointments’ to display previous Appointment history.
                              • Past Appointments display at the top, highlighted in gray.
                              • Upcoming Appointments display at the bottom with no highlight.
                              • Uncheck ‘Show Past Appointments’ to go back to only displaying the 
                                 Upcoming Appointments.
          • My Health Records
                    • The ‘View’ date range only filters the records that are currently displayed.
                    • If you select ‘Records Older than 30 days’ to display a history, you can then 
                       use the ‘View’ to select a specific date range to view of that history.
                              • Example: History shows back to 2020, but you only want to view 
                                 everything from 2022.

• Just a Reminder: 
         • If the patient selects My Account > Activity, this could take longer depending upon 
             how long they have been going to the practice.
          • New patients will take seconds, but if the patient has years of information, it could 
             take 5-10 min.

 X (6/13/2023)(12.7.0.24) Patient > Portal > Statement Payments

• Patients now have the option to make a credit card payment through the Patient Portal.
• Patient Statements must be uploaded to the Portal either via the Function or sent 
   manually from the patient Ledger.
• The Patient logs into the portal and goes to the ‘Statements’ area.
• They click ‘Make a Payment’, enter their credit card information then click the ‘PROCESS 
   TRANSACTION’ button.
• Every 30 min, PracticeWatch checks the Portal and downloads payments to the Patient 
   Ledger.

 X (8/9/2023)(12.7.0.25) Look-up Tables > Audit History

• The NEW command ‘Audit History’ was added to several tables to show a history of 
   changes made to the table. (Request) 

Compulink Healthcare Solutions | 1100 Business Center Circle | Newbury Park, CA 91320 | 805.716.8677 .
elearning@compulinkadvantage.com | www.compulinkadvantage.com               3



Hot Topics
• Highlight the record in the table that you want to view the Audit History for, then click the
   Audit History command.
• Information displayed:
          • When – Date and time change was made
          • Who – Name of the person logged in when the change was made
          • Action – Action that was taken, such as ‘Edit’
• Double click on a line to display the audit field by field changes.
          • Displays field name and information before and after the change.

 X (10/9/2023)(12.7.0.26) Appointment > Provider Web Appointment Viewer

• The Provider Web Appointment Viewer is a quick way for Providers to view their 
   Appointment schedule on-the-go.
• Information is in real time, so the practice MUST be on the Advantage Cloud environment.
• This is for viewing content only and not bi-directional.

• Accessing the Viewer:
          • On your computer or mobile device, go to: advantageprovider.com
          • On the ‘Log In’ page, enter the information below and click ‘Sign-In’.
                    • Compulink Account Number – Practice’s Compulink Account #
                    • User Name – Provider’s User name used to log into the Advantage software
                    • Password – Provider’s Password used to log into the Advantage software
• Selecting Information to View:
          • After signing in, set the information below and click ‘Update’:
                    • Location – Practice Location Code and Name
                              • Defaults to the main Location, but you may select a different one.
                              • Select ‘All’ to view Appointments for all Locations.
                    • Appointment Date – Date of Appointments you want to view
• Appointment Details:
          • The selected Location and Appointment Date display at the top.
          • Appointments are listed in Time order.
          • Details include:
                    • Patient Name - Last, First MI (Nickname)
                    • Location Code Appointment is scheduled at
                    • Time Appointment is scheduled
                    • Reason – Appointment Reason
                    • Remarks – Appointment Remarks
                              • Due to limited space on a mobile device, you must click the 
                                 Appointment to view the Remarks.
• Switching Between Views:
          • To view a different Location and/or Appointment Date, select from the drop-downs 
             and click the ‘Update’ button.
• Signing Out:
          • To sign out of the Web Viewer, click ‘Sign Out’ at the top.
          • This takes you back to the ‘Log In’ screen.

 X (10/20/2023)(12.7.0.26) Education > User-Focused > Hover

• Hover over an entry in the ‘Select Education Item to Review’ window to see hover window
   displaying the contents of the entry. (Request) 
• This is very helpful for reviewing the Education – Video entries prior to selecting them and
   being taken to Compulink University.

 X (11/1/2023)(12.7.0.26) Login > Location

• If your practice uses the CBSMobile option to prompt the staff to enter a Location upon 
   Logging into the software, the window has been updated.
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• Instead of typing in a Location, a ‘Select Location for Mobile User’ window opens to 
   display only the Locations that the Login ID is allowed to select from. (Request) 
• This is based upon the Location Group Restriction assigned in the Login IDs table.
• If no Restriction is assigned, all Locations display for selection.

Education

Education
 (12/29/2023)(12.7.0.25) Video > NEW: New User Welcome

• The Compulink University course 'New User Welcome’ was added.
• It can be found under the following Program: eLearning Resources
• Course Description: As a new user to Advantage, learn how to access, log in to and view 
   courses within Compulink University, your 24/7 online education portal.
• Published: 12/22/23 - Length: 3 Minutes

 (12/26/2023)(12.7.0.26) Compulink University > New User Registration

• New users added to your Advantage software Login IDs table will receive a ‘Welcome to 
   Compulink University’ email with their Login credentials.
• They will also find Compulink 101 courses waiting for them on ‘My Learning Track’.
• Everyone is registered for the 2 courses below, then based on their specialty and position,
   they are registered for additional courses.
          • Course 1 - New User Welcome
          • Course 2 - Activate: Patient Services and Demographics
• All auto-registered courses have a due date of 30 days.

 (12/26/2023)(12.7.0.26) Video > NEW: Activate: System and Financial Table 
Setup

• The Compulink University course 'Activate: System and Financial Table Setup’ was 
   added.
• It can be found under the following Program: Activate Advantage
• Course Description: Learn about System Setup default efficiencies and Financial Tables in 
   this Activate Advantage course.
• Published: 11/29/23 - Length: 23 Minutes

 (12/26/2023)(12.7.0.26) Video > NEW: Ledger: Print Commands

• The Compulink University course 'Ledger: Print Commands’ was added.
• It can be found under the following Program: Ledger
• Course Description: Review the options found on the Ledger > Print command menu.
• Published: 12/15/23 - Length: 21 Minutes

 (12/26/2023)(12.7.0.26) Video > NEW: Task Management Setup

• The Compulink University course 'Task Management Setup’ was added.
• It can be found under the following Program: Patient Flow
• Course Description: Learn about the tables supporting the Enterprise Task Management 
   feature. Includes the purpose of each table and how to build entries.
• Published: 12/15/23 - Length: 11 Minutes

 (12/26/2023)(12.7.0.26) Video > UPDATED: Activate: Miscellaneous Inventory 
Setup & Functionality

• The Compulink University course 'Activate: Miscellaneous Inventory Setup & Functionality’
   was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: Learn the basics of Inventory Setup, including how to update and 
   maintain the Vendors table and how to add stock items to the Inventory Database.
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• Published: 12/22/23 - Length: 9 Minutes

 (12/18/2023)(12.7.0.26) Video > NEW: Task Loc & Staff Group Assignment 
Control

• The Compulink University course 'Task Loc & Staff Group Assignment Control’ was added.
• It can be found under the following Program: Patient Flow
• Course Description: Learn about the Location and Staff Group Assignment controls related
   to the Task Management feature.
• Published: 12/15/23 - Length: 7 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Adding Patient ToDos

• The Compulink University course 'Adding Patient ToDos’ was updated.
• It can be found under the following Program: Patient Flow
• Course Description: This course explains how to access, add and mark ToDo items 
   complete on your patient accounts.
• Published: 12/15/23 - Length: 7 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Create an Encounter Favorite

• The Compulink University course 'Create an Encounter Favorite’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: This course will walk through the simple steps of creating an 
   encounter favorite for a specific tab.
• Published: 12/15/23 - Length: 6 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Data Mining: Adding an SQL Query

• The Compulink University course 'Data Mining: Adding an SQL Query’ was updated.
• It can be found under the following Program: Practice Admin
• Course Description: Review fields and options when adding an SQL Query.
• Published: 12/15/23 - Length: 14 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Enterprise Task Management

• The Compulink University course 'Enterprise Task Management’ was updated.
• It can be found under the following Program: Patient Flow
• Course Description: Learn about the Enterprise Task Management feature.
• Published: 12/15/23 - Length: 8 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Exam Efficiencies

• The Compulink University course 'Exam Efficiencies’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: This course shows how to add ultrasound images to a patient’s exam.
• Published: 12/15/23 - Length: 4 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: Ledger: Alternate Receipt Options

• The Compulink University course 'Ledger: Alternate Receipt Options’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Review the alternate receipt options found under the Ledger > Print 
   command and learn how to change the default receipt.
• Published: 12/15/23 - Length: 17 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: SMART Orders Setup Overview

• The Compulink University course 'SMART Orders Setup Overview’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: Learn how to create a new order set or edit an existing one.
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• Published: 12/15/23 - Length: 12 Minutes

 (12/18/2023)(12.7.0.26) Video > UPDATED: SMART Orders Window

• The Compulink University course 'SMART Orders Window’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: See how the Exam SMART Orders functionality streamlines the 
   selection of Assessments, Plans and Orders, based on your patient’s diagnosis.
• Published: 12/15/23 - Length: 5 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: Activate: EHR Basics

• The Compulink University course 'Activate: EHR Basics’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course introduces Clients to the basics of EHR. Learn how to 
   access EHR, create a layout, EHR Commands, information entry and much more.
• Published: 11/29/23 - Length: 23 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: Activate: EHR Basics for Addiction 
and Psych

• The Compulink University course 'Activate: EHR Basics for Addiction and Psych’ was 
   updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course introduces features related to EHR documentation and 
   functionality. Topics include layouts, icons, shortcuts and government compliance.
• Published: 11/29/23 - Length: 21 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: Adding a Patient Contact

• The Compulink University course 'Adding a Patient Contact’ was updated.
• It can be found under the following Program: Patient Flow
• Course Description: Review the Patient Contact screen, its purpose and definitions of all 
   field options.
• Published: 11/29/23 - Length: 8 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: EHR Field Edit Level

• The Compulink University course 'EHR Field Edit Level’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: Login Profile Right: EHR Field Edit Level.
• Published: 11/29/23 - Length: 3 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: EHR: Spell Check

• The Compulink University course 'Activate: EHR Basics’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: Review spell checking EHR memo fields.
• Published: 11/29/23 - Length: 2 Minutes

 (11/30/2023)(12.7.0.26) Video > UPDATED: Field Definition Command In EHR

• The Compulink University course 'Field Definition Command In EHR’ was updated.
• It can be found under the following Program: EHR: General Info
• Course Description: Quickly find exam field information for custom screens, SQL worklists
   and Crystal Reports using this new right click option. 
• Published: 11/29/23 - Length: 2 Minutes

 (11/16/2023)(12.7.0.26) Video > UPDATED: Ledger: Batch Posting

• The Compulink University course 'Ledger: Batch Posting’ was updated.
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• It can be found under the following Program: Ledger
• Course Description: Learn how the Batch Posting feature works for posting charges and 
   payments in a batch format in your patient ledgers.
• Published: 11/15/23 - Length: 8 Minutes

 (11/16/2023)(12.7.0.26) Video > UPDATED: Ledger: Collection Accounts

• The Compulink University course 'Ledger: Collection Accounts’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Explore the Ledger Collection module with efficiency tools designed to
   manage your overdue patient accounts.
• Published: 11/15/23 - Length: 9 Minutes

 (11/16/2023)(12.7.0.26) Video > UPDATED: Ledger: Payor Notes

• The Compulink University course 'Ledger: Payor Notes’ was updated.
• It can be found under the following Program: Ledger
• Course Description: This brief tutorial presents the Ledger Payor Notes functionality with 
   the companion RCM Insurance Follow-up Worklist.
• Published: 11/15/23 - Length: 4 Minutes

 (11/2/2023)(12.7.0.26) Video > NEW: Claim Denials Worklist

• The Compulink University course 'Claim Denials Worklist’ was added.
• It can be found under the following Program: Billing: Insurance
• Course Description: The Denial Claims worklist is an efficiency tool to locate and work all 
   denied claims sent electronically.
• Published: 10/31/23 - Length: 2 Minutes

 (11/2/2023)(12.7.0.26) Video > NEW: Instant Messaging

• The Compulink University course 'Instant Messaging’ was added.
• It can be found under the following Program: Communication
• Course Description: Quickly send a message to a staff member or group using Instant 
   Messaging through your Advantage software. Includes the Instant Message Review report
   for administrators.
• Published: 10/31/23 - Length: 4 Minutes

 (11/2/2023)(12.7.0.26) Video > NEW: Intro to Episodes of Care

• The Compulink University course 'Intro to Episodes of Care’ was added.
• It can be found under the following Program: Patient Flow
• Course Description: Briefly review the setup required to utilize the Episodes of Care 
   feature.
• Published: 10/31/23 - Length: 3 Minutes

 (11/2/2023)(12.7.0.26) Video > NEW: Order Set Auto Build

• The Compulink University course 'Order Set Auto Build’ was added.
• It can be found under the following Program: EHR: General Info
• Course Description: The Exam Order Set Auto-Build utilitiy automatically creates Order 
   Sets based on the provider’s exam documentation history.
• Published: 10/31/23 - Length: 2 Minutes

 (11/2/2023)(12.7.0.26) Video > NEW: PracticeWatch: Automating Patient 
Eligibility

• The Compulink University course 'PracticeWatch: Automating Patient Eligibility’ was 
   added.
• It can be found under the following Program: PracticeWatch
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• Course Description: Learn how to streamline your Batch Patient Eligibility with 
   PracticeWatch.
• Published: 10/31/23 - Length: 7 Minutes

 (11/2/2023)(12.7.0.26) Video > UPDATED: Patient Messaging

• The Compulink University course 'Patient Messaging’ was updated.
• It can be found under the following Program: Communication
• Course Description: Explore the E-Mail and Text messaging options available under the 
   Patient Print command.
• Published: 10/31/23 - Length: 2 Minutes

 (10/26/2023)(12.7.0.26) Video > NEW: Provider Web Appointment Viewer

• The Compulink University course 'Provider Web Appointment Viewer’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Learn about the new Provider Web Appointment Viewer, a quick way 
   for Providers to view their schedule on-the-go.
• Published: 10/13/23 - Length: 3 Minutes

 (10/26/2023)(12.7.0.26) Video > UPDATED: Appointment Scheduling I

• The Compulink University course 'Appointment Scheduling I’ was updated.
• It can be found under the following Program: Appointments
• Course Description: Learn how to schedule, reschedule, change the schedule view, modify
   appointment status, cancel and move appointments.
• Published: 10/13/23 - Length: 13 Minutes

 (10/26/2023)(12.7.0.26) Video > UPDATED: Appointment Scheduling II

• The Compulink University course 'Appointment Scheduling II’ was updated.
• It can be found under the following Program: Appointments
• Course Description: Learn about the following Appointment commands: Search, Refresh, 
   Block, Print, Wait List and Daily Notes.
• Published: 10/13/23 - Length: 18 Minutes

 (10/26/2023)(12.7.0.26) Video > UPDATED: Appointment Template Setup

• The Compulink University course 'Appointment Template Setup’ was updated.
• It can be found under the following Program: Appointments
• Course Description: Learn about the different template types, how to create a template 
   and how to set up your template schedule. A demonstration of the Move Template utility 
   is included.
• Published: 10/13/23 - Length: 29 Minutes

 (10/20/2023)(12.7.0.26) Video > NEW: PracticeWatch: General Overview

• The Compulink University course 'PracticeWatch: General Overview’ was added.
• It can be found under the following Program: PracticeWatch
• Course Description: This course reviews the table commands, panel details and menu 
   options in the PracticeWatch Dashboard.
• Published: 10/13/23 - Length: 16 Minutes

 (10/20/2023)(12.7.0.26) Video > NEW: What is New in V12.7.0.26

• The Compulink University course 'What is New in V12.7.0.26’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Review enhancements incorporated in V12.7.0.26 including new 
   audits for inventory, new/updated reports and more.
• Published: 10/13/23 - Length: 6 Minutes
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 (10/6/2023)(12.7.0.25) Video > NEW: EHR: 2023 Regulatory Compliance 

Enhancements

• The Compulink University course 'EHR: 2023 Regulatory Compliance Enhancements’ was 
   added.
• It can be found under the following Program: EHR: General Info
• Course Description: Review highlights of regulatory compliance enhancements in 2023 
   that affect exam screens/documentation.
• Published: 9/29/23 - Length: 12 Minutes

 (10/6/2023)(12.7.0.25) Video > NEW: Episodes of Care

• The Compulink University course 'Episodes of Care’ was added.
• It can be found under the following Program: Patient Flow
• Course Description: Review the functionality and benefits of the proper set up and use of 
   Episodes of Care. 
• Published: 9/29/23 - Length: 9 Minutes

 (10/6/2023)(12.7.0.25) Video > NEW: Logging In To Your Advantage Software

• The Compulink University course 'Logging In To Your Advantage Software’ was added.
• It can be found under the following Program: Practice Admin
• Course Description: Learn how to log in to your Advantage Software.
• Published: 9/29/23 - Length: 3 Minutes

 (10/6/2023)(12.7.0.25) Video > UPDATED: Updating To Line Item Posting 
Ledgers

• The Compulink University course 'Updating To Line Item Posting Ledgers’ was updated.
• It can be found under the following Program: Ledger
• Course Description: This course is essential for anyone planning to upgrade from 
   Standard to Line Item Posting. It outlines the steps of the update process, reviews the 
   benefits of upgrading and explains the differences between Standard and LIP ledgers. 
   You'll learn what to expect throughout the process and what is expected on your end both
   before and after updating.
• Published: 9/29/23 - Length: 16 Minutes

 (9/15/2023)(12.7.0.25) Video > NEW: Creating an Exam Order Set

• The Compulink University course 'Creating an Exam Order Set’ was added.
• It can be found under the following Program: EHR: General Info
• Course Description: Walk through the steps for creating an Order Set.
• Published: 9/14/23 - Length: 4 Minutes

 (9/15/2023)(12.7.0.25) Video > NEW: Integrated Payment Processing

• The Compulink University course 'Integrated Payment Processing’ was added.
• It can be found under the following Program: Practice Admin
• Course Description: Learn about the benefits and workflow of integrated payment 
   processing within your Advantage software.
• Published: 9/14/23 - Length: 5 Minutes

 (9/15/2023)(12.7.0.25) Video > NEW: PracticeWatch: Installation

• The Compulink University course 'PracticeWatch: Installation’ was added.
• It can be found under the following Program: PracticeWatch
• Course Description: This course reviews the required administrative rights and installation
   process for PracticeWatch.
• Published: 9/14/23 - Length: 9 Minutes
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Education
 (9/15/2023)(12.7.0.25) Video > UPDATED: Account Management Tools: Before 

And After Billing

• The Compulink University course 'Account Management Tools: Before And After Billing’ 
   was updated.
• It can be found under the following Program: Billing: Insurance
• Course Description: Learn about the many tools available to manage your accounts 
   including Reports, Worklists and Payor Notes.
• Published: 9/14/23 - Length: 16 Minutes

 (9/6/2023)(12.7.0.25) Video > UPDATED: Dictionary Utilities

• The Compulink University course 'Dictionary Utilities’ was updated.
• It can be found under the following Program: About Version 12.7
• Course Description: This course reviews the System Administrator Dictionary Utilities 
   including Table Maintenance, Reindex & Recalculating.
• Published: 8/31/23 - Length: 18 Minutes

 (9/6/2023)(12.7.0.25) Video > UPDATED: Functions: Acct. Statements and 
Overdue Notices

• The Compulink University course 'Functions: Acct. Statements and Overdue Notices’ was 
   updated.
• It can be found under the following Program: Billing: Patient
• Course Description: This course reviews the Account Statement and Payment Overdue 
   Notice functions, defining the options and demonstrating how to run the processes.
• Published: 8/31/23 - Length: 15 Minutes

 (9/6/2023)(12.7.0.25) Video > UPDATED: Insurance Billing: Basic Charge Posting

• The Compulink University course 'Insurance Billing: Basic Charge Posting’ was updated.
• It can be found under the following Program: Billing: Insurance
• Course Description: Learn the proper way to post ledger charges in preparation for 
   Professional claims (CMS1500) Insurance Billing.
• Published: 8/31/23 - Length: 19 Minutes

 (9/6/2023)(12.7.0.25) Video > UPDATED: Patient Billing & Statements Service

• The Compulink University course 'Patient Billing & Statements Service’ was updated.
• It can be found under the following Program: Billing: Patient
• Course Description: Learn how to request, install and set up the Patient Billing and 
   Statements service from Change Healthcare/Optum. Review the process for preparing 
   Recalls and Statements and how to transfer files using the Filezilla software.
• Published: 8/31/23 - Length: 16 Minutes

 (9/6/2023)(12.7.0.25) Video > UPDATED: Scanning in Advantage

• The Compulink University course 'Scanning in Advantage’ was updated.
• It can be found under the following Program: Patient Flow
• Course Description: This course reviews scanning documents in the Patient 
   Demographics, Insurance and Exam.
• Published: 8/31/23 - Length: 14 Minutes

 (8/18/2023)(12.7.0.24) Video > NEW: Ledger: Posting Adjustments

• The Compulink University course 'Ledger: Posting Adjustments' was added.
• It can be found under the following Program: Ledger
• Course Description: Learn how to post various ledger adjustments using the Adjust or 
   Create Unapplied Payments commands. This includes how to handle overpayments and 
   $0.00 adjustments. 
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Education
• Published: 7/28/23 - Length: 16 Minutes

 (8/18/2023)(12.7.0.25) Video > NEW: What is New in V12.7.0.25

• The Compulink University course 'What is New in V12.7.0.25’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Learn about the 2023 QPP Promoting Interoperability reports, User 
   Grid Menu controls, a new PracticeWatch task scheduling efficiency and more!
• Published: 8/16/23 - Length: 11 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Activate: Appointment Scheduling

• The Compulink University course 'Activate: Appointment Scheduling’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course teaches attendees the basics of Appointment Scheduling:
   Scheduling, Re-scheduling and Canceling Appointments.
• Published: 8/15/23 - Length: 7 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Activate: Patient Services and 
Demographics

• The Compulink University course 'Activate: Appointment Scheduling’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course introduces Patient Demographics features. Upon 
   completion, attendees will be able to create and search for a patient record, add 
   insurance information and much more.
• Published: 8/15/23 - Length: 25 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Checking in a New Patient

• The Compulink University course 'Checking in a New Patient’ was updated.
• It can be found under the following Program: Patient Flow
• Course Description: Review the steps for checking in a patient including marking their 
   appointment Kept, scanning their insurance card and HIPAA agreement as well as 
   collecting a co-pay. Print a Patient Information sheet to verify their data is current. 
• Published: 8/15/23 - Length: 12 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Ledger: Collection Setup

• The Compulink University course 'Ledger: Collection Setup’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Learn what setup is required to support the Collection Tracking 
   module in patient ledgers.
• Published: 8/15/23 - Length: 12 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Ledger: Posting Insurance Payments

• The Compulink University course 'Ledger: Posting Insurance Payments’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Walk through different scenarios for posting incoming insurance 
   payments, including how to handle $0.00 EOBs.
• Published: 8/15/23 - Length: 18 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Ledger: Posting Refunds

• The Compulink University course 'Ledger: Posting Refunds’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Learn how to post insurance and account responsible refunds as well 
   as how to properly use the Void Entry and Return commands.
• Published: 8/15/23 - Length: 19 Minutes
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Education
 (8/18/2023)(12.7.0.25) Video > UPDATED: Ledger: Prepayments and Unapplied 

Payments

• The Compulink University course 'Ledger: Prepayments and Unapplied’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Learn how to post Prepayments and distribute Unapplied Payments in
   your patient ledgers.
• Published: 8/15/23 - Length: 8 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Patient Portal Updates

• The Compulink University course 'Patient Portal Updates’ was updated.
• It can be found under the following Program: Patient Portal
• Course Description: Review the latest updates made to the Patient Portal that coincide 
   with the release of V12.7.0.24/greater.
• Published: 8/15/23 - Length: 3 Minutes

 (8/18/2023)(12.7.0.25) Video > UPDATED: Service Fees Table V12.7

• The Compulink University course 'Service Fees Table V12.7’ was updated.
• It can be found under the following Program: Tables: Financial
• Course Description: Learn how to build and maintain your financial Service Fee table, 
   where your billing codes and fees are stored.
• Published: 8/15/23 - Length: 20 Minutes

 (8/2/2023)(12.7.0.24) Video > NEW: Adding Patient Insurance

• The Compulink University course 'Adding Patient Insurance’ was added.
• It can be found under the following Program: Patient Flow
• Course Description: Learn how to add an insurance record with patient and insured 
   information.
• Published: 7/28/23 - Length: 17 Minutes

 (8/2/2023)(12.7.0.24) Video > NEW: EHR Fee Posting Window: Internal 
Counts/Logical Values

• The Compulink University course 'EHR Fee Posting Window: Internal Counts/Logical 
   Values’ was added.
• It can be found under the following Program: EHR: General Info
• Course Description: Gain an understanding of where the software is looking in the exam 
   records when 'counting' data points to determine the recommended E&M coding level to 
   charge for.
• Published: 7/28/23 - Length: 13 Minutes

 (8/2/2023)(12.7.0.24) Video > NEW: Patient Co-Pay Functionality

• The Compulink University course 'Patient Co-Pay Functionality’ was added.
• It can be found under the following Program: Ledger
• Course Description: Review how to set a per-visit Co-Pay and explore options for 
   collecting and applying Co-Pay payments.
• Published: 7/28/23 - Length: 7 Minutes

 (8/2/2023)(12.7.0.24) Video > NEW: What is New in V12.7.0.24

• The Compulink University course 'What is New in V12.7.0.24’ was added.
• It can be found under the following Program: About Version 12.7
• Course Description: Let's review enhancements available in V12.7.0.24. This includes 
   items added to the software since the initial release of Version 12.7.
• Published: 6/13/23 - Length: 11 Minutes
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Education
 (8/2/2023)(12.7.0.24) Video > UPDATED: Activate: General Table Setup

• The Compulink University course 'Activate: General Table Setup’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course teaches Administrators and Management staff the basics
   of General Table Setup.
• Published: 7/28/23 - Length: 18 Minutes

 (8/2/2023)(12.7.0.24) Video > UPDATED: Activate: Insurance and Ledger Basics

• The Compulink University course 'Activate: Insurance and Ledger Basics’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course teaches Insurance and Ledger Basics.
• Published: 7/28/23 - Length: 24 Minutes

 (8/2/2023)(12.7.0.24) Video > UPDATED: Ledger: Posting Responsible Payments

• The Compulink University course 'Ledger: Posting Responsible Payments’ was updated.
• It can be found under the following Program: Ledger
• Course Description: Learn about each of the Credit > Responsible commands for posting 
   patient/responsible payments to the ledger.
• Published: 7/28/23 - Length: 12 Minutes

 (7/21/2023)(12.7.0.24) Video > NEW: Activate: New Client Onboarding

• The Compulink University course 'Activate: New Client Onboarding’ was added.
• It can be found under the following Program: Activate Advantage
• Course Description: This course introduces new clients to Activate Advantage and the 
   Compulink Teams who will be assisting them during the onboarding process.
• Published: 7/14/23 - Length: 7 Minutes

 (7/21/2023)(12.7.0.24) Video > NEW: Inventory Tables

• The Compulink University course 'Inventory Tables was added.
• It can be found under the following Program: Inventory
• Course Description: This course reviews the Inventory tables including Adjustments, 
   Order Comments, SKU Formulas, Vendors and more. 
• Published: 7/14/23 - Length: 12 Minutes

 (7/21/2023)(12.7.0.24) Video > NEW: RCM: Daily Pending Claims with Errors 
Communications

• The Compulink University course 'RCM: Daily Pending Claims with Errors Communications’
   was added.
• It can be found under the following Program: AdvantageRCM
• Course Description: New with Version 12.7, the designated RCM contact in your practice 
   will receive daily communications when pending claims with errors exceed $10.00.
• Published: 7/14/23 - Length: 2 Minutes

 (7/21/2023)(12.7.0.24) Video > UPDATED: Client Web Portal Education 
Resources

• The Compulink University course 'Client Web Portal Education’ was updated.
• It can be found under the following Program: eLearning Resources
• Course Description: Tour the eLearning and Training Education resources on the client 
   web portal.
• Published: 7/14/23 - Length: 3 Minutes

 (7/21/2023)(12.7.0.24) Video > UPDATED: DMA Electronic Signature Options and
Function
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Education
• The Compulink University course 'DMA Electronic Signature Options and Function’ was 
   updated.
• It can be found under the following Program: Word Processing
• Course Description: Review the Needs Signature Functionality and options. Includes: Do 
   Not Save Image of Document, E-Fax and Signature Update.
• Published: 7/14/23 - Length: 10 Minutes

 (7/21/2023)(12.7.0.24) Video > UPDATED: ELearning Tools and Resources

• The Compulink University course 'Elearning Tools and Resources’ was updated.
• It can be found under the following Program: eLearning Resources
• Course Description: Learn about the many education resources available on our client 
   web portal, in Compulink University and in our Online Help file.
• Published: 7/14/23 - Length: 22 Minutes

 (7/21/2023)(12.7.0.24) Video > UPDATED: Overview: System Administrator 
Utilities V12.7

• The Compulink University course 'Overview: System Administrator Utilities V12.7’ was 
   updated.
• It can be found under the following Program: System Admin
• Course Description: Review the utilities located under the System Administrator menu in 
   V12.7/greater.
• Published: 6/27/23 - Length: 4 Minutes

 (7/21/2023)(12.7.0.24) Video > UPDATED: Release Notes & Resources Document

• The Compulink University course 'Release Notes & Resources Document’ was updated.
• It can be found under the following Program: eLearning Resources
• Course Description: Stay in the loop with the Release Notes & Educational Resources 
   Resources document on the Compulink Client Web Portal.
• Published: 7/14/23 - Length: 4 Minutes

 (6/29/2023)(12.7.0.24) Video > NEW: 2023 PI Public Health & Clinical Data 
Exchange Objective

• The Compulink University course '2023 PI Public Health & Clinical Data’ was added.
• It can be found under the following Program: Govt Compliance
• Course Description: Review the measures within the Public Health and Clinical Data 
   Exchange objective. Navigate to the Registries & HIE Interface Request page on the 
   Compulink Client Web Portal.
• Published: 6/27/23 - Length: 16 Minutes

 (6/29/2023)(12.7.0.24) Video > NEW: EHR: Real Time Note Update Engine

• The Compulink University course 'Real Time Note Update Engine’ was added.
• It can be found under the following Program: EHR: General Info
• Course Description: Review how the Real Time Note Update Engine works and how note 
   templates are created in your EHR tables. 
• Published: 6/27/23 - Length: 9 Minutes

 (6/29/2023)(12.7.0.24) Video > NEW: MACRA: 2023 PY Changes

• The Compulink University course 'MACRA: 2023 PY Changes’ was added.
• It can be found under the following Program: Govt Compliance
• Course Description: Here's an overview of changes to the MACRA program for the 2023 
   performance year.
• Published: 6/27/23 - Length: 11 Minutes

 (6/29/2023)(12.7.0.24) Video > NEW: Portal: Statements & Patient Payments
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Education

• The Compulink University course 'Portal: Statements & Patient Payments’ was added.
• It can be found under the following Program: Patient Portal
• Course Description: Review how to send a statement to the Patient Portal and see how 
   online payments made on the Portal get automatically posted to the ledgers in 
   Advantage.
• Published: 6/27/23 - Length: 2 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Activate: Orientation & Product 
Briefing

• The Compulink University course 'Activate: Orientation & Product Briefing’ was updated.
• It can be found under the following Program: Activate Advantage
• Course Description: This course is an overview of the self-paced eLearning tool for 
   Advantage clients who want a quick and comprehensive implementation.
• Published: 6/16/23 - Length: 5 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Control Access with Login Profile 
Rights

• The Compulink University course 'Control Access with Login Profile Rights’ was updated.
• It can be found under the following Program: System Admin
• Course Description: This course reviews the importance of correctly assigning staff 
   permission in your Login Profiles. It also outlines tips for success to help you get started.
• Published: 6/16/23 - Length: 3 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Portal: Access Your Health 
Information

• The Compulink University course 'Portal: Access Your Health Information’ was updated.
• It can be found under the following Program: Patient Portal
• Course Description: Learn how to access and view health information your provider has 
   uploaded to your Patient Portal.
• Published: 6/16/23 - Length: 2 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Portal: Message Your Provider

• The Compulink University course 'Portal: Message Your Provider’ was updated.
• It can be found under the following Program: Patient Portal
• Course Description: Learn how to message your provider from within the Patient Portal.
• Published: 6/16/23 - Length: 1 Minute

 (6/29/2023)(12.7.0.24) Video > UPDATED: Portal: Patient Education Resources

• The Compulink University course 'Portal: Patient Education Resources’ was updated.
• It can be found under the following Program: Patient Portal
• Course Description: Learn about the videos and online Help available to your patients on 
   the MySecureHealthData sign in page.
• Published: 6/27/23 - Length: 2 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Portal: Registration And Logging In

• The Compulink University course 'Portal: Registration And Logging In’ was updated.
• It can be found under the following Program: Patient Portal
• Course Description: This short video will explain the step by step process for how to 
   register and validate a patient account on the portal, from the patient's perspective.
• Published: 6/16/23 - Length: 2 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Revenue Opportunity Report

• The Compulink University course 'Revenue Opportunity Report’ was updated.
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Education
• It can be found under the following Program: Reports: Financial
• Course Description: The Revenue Opportunity Report highlights multiple ways your 
   practice can reduce costs and improve efficiency with Compulink's add-on services.
• Published: 6/12/23 - Length: 7 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Table Edit Controls

• The Compulink University course 'Table Edit Controls’ was updated.
• It can be found under the following Program: System Admin
• Course Description: Review the Table Edit Controls where your system administrator can 
   configure user access at the individual field level.
• Published: 6/16/23 - Length: 2 Minutes

 (6/29/2023)(12.7.0.24) Video > UPDATED: Web Registration: Reprocess a 
Registration Record

• The Compulink University course 'Web Registration: Reprocess a Registration Record’ was 
   updated.
• It can be found under the following Program: Web Reg
• Course Description: Learn how to requeue a Patient's Registration Record.
• Published: 6/16/23 - Length: 3 Minutes

 (6/21/2023)(12.7.0.24) Video > NEW: Login IDs Table

• The Compulink University course 'Login IDs Table’ was added.
• It can be found under the following Program: System Admin
• Course Description: Learn how to create User Login IDs for your staff. This course reviews
   each of the data entry fields within this table. Version 12.7+.
• Published: 6/16/23 - Length: 23 Minutes

 (6/21/2023)(12.7.0.24) Video > NEW: Login Profile Rights Table

• The Compulink University course 'Login Profile Rights Table’ was added.
• It can be found under the following Program: System Admin
• Course Description: Review the purpose and maintenance of the Login Profiles Table. 
   Version 12.7+.
• Published: 6/16/23 - Length: 8 Minutes

 (6/21/2023)(12.7.0.24) Video > NEW: Medication Management Workflow

• The Compulink University course 'Medication Management Workflow’ was added.
• It can be found under the following Program: EHR: Psych
• Course Description: Review the Advantage tools available in to assist you with managing 
   your client's medications.
• Published: 6/16/23 - Length: 14 Minutes

 (6/21/2023)(12.7.0.24) Video > NEW: Portal: Online Statements & Payments

• The Compulink University course 'Portal: Online Statements & Payments’ was added.
• It can be found under the following Program: Patient Portal
• Course Description: Learn how to view your statement and make a payment to your 
   provider's office on the Patient Portal. 
• Published: 6/16/23 - Length: 2 Minutes

 (6/21/2023)(12.7.0.24) Video > NEW: Portal: View Appointments

• The Compulink University course 'Portal: View Appointments’ was added.
• It can be found under the following Program: Patient Portal
• Course Description: Quickly view your upcoming and past appointments on the Patient 
   Portal.
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Education
• Published: 6/16/23 - Length: 1 Minute

 (6/1/2023)(12.7.0.24) Video > NEW: Claims: Table Setup & Posting Workflow 
V12.7+

• The Compulink University course 'Claims: Table Setup & Posting Workflow V12.7+’ was 
   added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Review key look-up tables associated with claims processing, 
   V12.7/greater. Proper setup of the patient’s insurance record and posting ledger charges 
   complete the workflow.
• Published: 6/1/23 - Length: 20 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: Insurance Billing: Expanded Claim Screens

• The Compulink University course 'Insurance Billing: Expanded Claim Screens’ was added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Review the Expanded Claim Screen area in detail, including 
   references to where information appears on the applicable claim form.
• Published: 6/1/23 - Length: 21 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: Ledger: Options Commands V12.7+

• The Compulink University course 'Ledger: Options Commands V12.7+’ was added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Learn the functionality of each item on the Ledger Options command 
   menu.
• Published: 6/1/23 - Length: 30 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: Ledger: Posting Charges I V12.7+

• The Compulink University course 'Ledger: Posting Charges I V12.7+’ was added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Take a deep dive into the Ledger charge posting screen.
• Published: 6/1/23 - Length: 25 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: Ledger: Posting Charges II V12.7+

• The Compulink University course 'Ledger: Posting Charges II V12.7+’ was added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Learn how to post a Service, Material or X-Ray charge to your patient
   Ledgers.
• Published: 6/1/23 - Length: 16 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: Ledger: View Commands V12.7+

• The Compulink University course 'Ledger: View Commands V12.7+’ was added.
• It can be found under the following Program: Ledger Posting & Insurance Claims
• Course Description: Learn the function of each item on the Ledger View command menu.
• Published: 6/1/23 - Length: 16 Minutes

 (6/1/2023)(12.7.0.24) Video > NEW: User Lock-Out And Password Management

• The Compulink University course 'User Lock-Out And Password Management’ was added.
• It can be found under the following Program: System Security
• Course Description: Discover how passwords can be reset, both on-demand options and 
   automated. Learn about User Lock-Out options and how to deactivate User accounts.
• Published: 6/1/23 - Length: 9 Minutes

 (6/1/2023)(12.7.0.24) Video > UPDATED: Inventory: Preparing for an Audit
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Education
• The Compulink University course 'Inventory: Preparing for an Audit’ was updated.
• It can be found under the following Program: Inventory
• Course Description: This course provides the recommended steps to prepare for a 
   successful audit.
• Published: 6/1/23 - Length: 8 Minutes

Appointment

Appointment > Commands
 (5/11/2023)(12.7.0.23) Utility > Reasons > Detail Switch > Location and Staff 

Control

• A second Detail > Switch option for Location and Staff Control was added. (Request) 
• This allows the practice to control which Appointment Reasons are available for scheduling
   at specified Locations and/or for specified Providers.
• This filter uses the Location/Provider that was selected for the Appointment, not the 
   Location/Login of the staff making the Appointment.
          • Staff ‘ABC’ at Location ‘001’ is making an Appointment for Provider ‘XYZ’ at 
             Location ‘002’.
          • Appointment Reasons display for the Location Group that ‘002’ is connected to, 
             and/or the Staff Group that ‘XYZ’ is connected to.
• Highlight the Appointment Reason and select Detail > Switch.
          • The window at the bottom changes to Multiple Resource Scheduling.
          • Select Detail > Switch again and it changes to Location and Staff Control.
• Use Detail > Add to connect a Location Group and/or a Login/Staff Group to filter the 
   Reasons. 
• There is also an option to set the Display Order.

 (8/4/2023)(12.7.0.25) Utility > Template Schedule > Calendar

• The calendar that was removed in a previous version has been added back in per client 
   request. (Request)

Communication
 (10/9/2023)(12.7.0.26) Instant Message > Access Patient

• You now have the option to access the patient Demographics while the Instant Message 
   window is open. (Request)

Customization
 (6/12/2023)(12.7.0.24) Smart Function Editor > ALL > Same Name

• When duplicating or creating a new Smart Function and saving, if the same name is found
   on a visible Compulink-owned entry, the following message displays: Visible 
   SmartFunction with SAME Name Already Exists! Do you want to Continue?
• Click ‘Yes’ to save the entry with the same name and automatically check the Hide field 
   on the Compulink-owned entry. (Request) 
• Click ‘No’ to stay in edit mode and change the name to something that doesn’t match a 
   visible Compulink-owned entry.
• A ‘Visible’ entry is one that does NOT have the Hide field checked.
          • If the Hide field is checked, it is already hidden and does not display the message.
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Data Mining
 (6/12/2023)(12.7.0.24) Criteria > Detail > Location and Staff Control

• A Detail option was added to allow for Location and Staff Control. (Request) 
• Use Detail > Add to connect a Location Group and/or a Login/Staff Group to filter the 
   Data Mining records.

 (5/16/2023)(12.7.0.22) Criteria > Display Field List > Number of Fields 
Increased

• The number of fields allowed in the Display Field List was increased from 10 to 40. 
   (Request) 
• The Crystal Report output was updated to merge the increased number of fields.
          • The data wraps around to multiple rows if needed; 10 fields appear on each row.
                    • Each row has its own alternating row color so each row of data is distinct 
                       from the rows above and below it.
          • If exporting, we recommend selecting Microsoft Excel 97-2000 – Data only (XLS).
                    • Data exports in one row and may be opened in Excel or LibreOffice.
                    • If the desired final output is a CSV file, we recommend exporting in the 
                       above format followed by saving or exporting the data to CSV format.

Exam

Exam > General & Display Changes
 (5/12/2023)(12.7.0.22) General > E-Rx Pharmacy Selection

• Selecting a Pharmacy without an NPI now displays a message. (Request) 
• If the Pharmacy NPI is missing, the following message displays: Pharmacy Selected is 
   missing necessary IDs to Submit Rx Electronically! Press YES to Confirm Selection! 
• NOTE: If you use a Pharmacy without an NPI, the Rx will NOT be sent electronically.
• This functionality works when selecting from the Patient Demographics, Medication PopUp
   screen and E-Rx screen.

 (5/16/2023)(12.7.0.23) General > Supervising Provider

• The Provider listed in the ‘Supervising Provider’ field is now allowed to edit the Exam 
   record even if it has been signed off on by another Provider. (Request) 
• This is only available on the record with the field populated, not across all records.
• Example:
          • Provider John Smith selects Janet Steele as the Supervising Provider, completes 
             the Exam and signs off (locking the record).
          • Provider Janet Steele logs into the software and is able to edit the specific Exam 
             with her listed as the Supervising Provider.
          • Provider Chris Johnson logs into the software and is NOT able to edit the Exam.

 (8/22/2023)(12.7.0.25) General > Data Entry > Complaint

• The Smart Function that populates the Complaint Narrative Details was updated with the 
   following: (Request) 
          • Free-type in the beginning of the field:
                    • The user may free-type in the beginning of the field, and if they click back 
                       into one of the individual data fields, it does not overwrite the free-texted 
                       information.
                    • Type the information and put a period after.
                    • Example: Free-text. Beginning of next sentence
          • Free-type in the middle of the data in the field:
                    • If they type within the data that populated the field, they must have it 
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Exam > General & Display Changes
                       sentence format. 
                    • The sentence before has a period, then they type their information and put 
                       a period after.
                    • Example: end of previous sentence. Free-text. Beginning of next sentence
          • Free-type at the end of the field:
                    • The user may free-type at the end of the field, and if they click back into 
                       one of the individual data fields, it does not overwrite the free-texted 
                       information.
                    • Type the information and put a period after.
                    • If you forget, the software adds the period for you after exiting the field.
                    • Example: Free-text. Beginning of next sentence
          • Updated formatting for commas and spaces:
                    • If more than one item is typed in the individual fields with commas but no 
                       spaces, when the narrative is built, the spaces are added.
                    • Example: 
                              • Data entry: light,sound,vibration
                              • Narrative formatting: light, sound, vibration
          • Updated formatting for commas and the word ‘and’:
                    • If more than one item is selected in the individual fields, when the narrative
                       is built, the formatting contains commas and the word ‘and’ if needed.
                    • Example 1: Aggravation is experienced from light and sound.
                    • Example 2: Aggravation is experienced from light, sound and vibration.

• This includes the Smart Function that populates the field with information imported from 
   Web Registration.

 (6/23/2023)(12.7.0.24) General > Data Entry > Duplicate Diagnosis

• If you try to add a Diagnosis to the Exam that is already listed for that encounter, the 
   following message displays upon exit of the Code field: Unable to Locate Code or Code 
   Already Exists for Encounter!

 (8/11/2023)(12.7.0.26) General > Data Entry > Forward to Labels

• Smart Functions used to forward data may now forward to a CBSDBLabel field. (Request) 
          • SF.ForwardFieldGroup
          • SF.TabForwardVisitSelect
          • SF.TabForwardLastValue
          • SF.TabForwardLastPositive

 (6/23/2023)(12.7.0.24) General > Data Entry > Real Time Note Update Engine

• This functionality is now available in the Diagnosis Assessment and Plans table (Utility > 
   Look-up Tables > EHR > Assessment/Plan > Items). (Request) 

• Throughout all available areas, when merging the note into the Exam record, the cursor is
   placed at the end of the text, allowing the Provider to enter additional information.

• The option to merge an Exam sub-table record was added.
          • This merges the FIRST sub-table record entered for that Exam.
          • Within the note expression, enter [sub-table name.field name]
          • Example: Today we performed the test: [ExamTest.Name].

• The option to prompt for additional items based upon the option selected.
          • Use the ^ to append additional prompts.
          • Example: {Suggested Treatment |rest in dark room|MS|cold 
compress;massage;OTC Meds^Med Type {OTC Type|Tylenol|MS|Advil;Ibuprofin;} was 
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Exam > General & Display Changes
prescribed.;}.

 (6/23/2023)(12.7.0.25) General > Data Entry > Start Time

• The Exam Start Time no longer defaults to the system time. (Request) 17954
• This allows the user to right click in the field and populate the correct time when starting 
   the Exam.

 (8/11/2023)(12.7.0.25) General > Data Entry > Surgery and Treatment

• When attaching a High Risk History item to a Surgery or Treatment, it no longer opens an
   additional memo field. (Request) 
• Data is added to the existing memo field on the PopUp tab and the Provider may enter 
   additional information as needed.

 (8/4/2023)(12.7.0.25) General > Data Entry > Surgery, Test and Treatment

• If the ‘Same Day Service’ box is checked in the Surgery, Test and Treatment tables, the 
   Procedure Status field defaults to ‘Completed’, otherwise ‘Preparation’. (Request)

 (10/24/2023)(12.7.0.26) General > Images > Dicom Viewer

• The Advantage Dicom Viewer is used to display images stored within the patient’s medical
   record in either jpeg (.jpg) or bitmap (.bmp) format.
• A new dicomviewer.ini file is added to your Advantage product folder upon update.
          • This is dropped into the ims\tools folder.
• This file allows the user to manage settings for the viewer.
• File contents:
     [main]
     SortChron=false
     InitialMaximize=true
     InitialRibbonVisible=false
     InitialViewMode=single
     InitialScale=100
• Changing the settings:
          • SortChron – Set to ‘true’ to sort the images based on their content dates 
             chronologically from most recent to oldest, otherwise set to ‘false’ to sort oldest to
             most recent.
          • InitialMaximize – Set to ‘true’ to maximize the image to full screen upon launching 
             the viewer, otherwise set to ‘false’.
          • InitialRibbonVisible – Set to ‘true’ to show the ribbon of images at the bottom as 
             soon as the viewer launches, otherwise set to ‘false’ to hide.
                    • The ribbon can be opened manually once the viewer is launched.
          • InitialViewMode – Set to ‘single’ to view one image at a time, otherwise set to 
             ‘dual’ to view 2 images side-by-side.
          • InitialScale – Set to the scale you want to see the images, like ‘100’, or set to ‘fit’ 
             to have the images fit to screen.

Exam > Commands
 (8/4/2023)(12.7.0.25) Edit > Confirmation Message

• If clicking ‘Edit’ on an Exam date prior to the current date, the following message 
   displays: Do you REALLY want to Edit an OLD Record? (Request)

Exam > E-Rx
 (8/31/2023)(12.7.0.25) E-Rx > Command (Sign) > State Requirements
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Exam > E-Rx
• Some states consider certain drugs to be narcotics and some states do not. 
• Even if the government says that they are not, it is up to the state.
• The DEA schedules were updated to accommodate this.
• The schedule is based on the Pharmacy where the Rx will be picked up.
• If the state views the medication as a narcotic, it requires the provider to be licensed to 
   prescribe it and sign the Rx. (Request)

 (5/12/2023)(12.7.0.22) E-Rx > Review and Xmit > Sign

• For Providers that prescribe schedule drugs, clicking on Review and Xmit automatically 
   takes you to the Sign functionality. (Request) 
• In the Review screen, you have the option of Review Only or Review and Xmit.
• Selecting Review Only reviews the medication and takes you back to the E-Rx window 
   where you have to click Sign.
• Selecting Review and Xmit reviews the medication and brings up the two-factor 
   authentication window.
• Click ‘Yes’ to continue and you are prompted to enter your PIN for the ActivClient Login.
• Once the token PIN is entered, the Rx is transmitted.

Exam > Layouts & Tabs
 (8/4/2023)(12.7.0.25) Tab(s) > EDITED: PopUpDiag

• Tab Name: PopUpDiag
• Tab label: Diagnosis

• Description field
          • Type in part of a Diagnosis and open the table.
          • The search looks for a character match at the beginning of a whole word and not in
             the middle of a word. (Request) 
          • Example: Type in ‘traumatic’
                    • Search finds all Diagnoses with ‘traumatic’ as an individual word.
                    • Search does NOT find Diagnoses with ‘nontraumatic’ since it starts with non.

 (8/18/2023)(12.7.0.25) Tab(s) > EDITED: PopUpGoalSteps

• Tab Name: PopUpGoalSteps
• Tab label: Objective

• Objective Updates panel
          • This is a NEW panel added to the tab for display only.
          • Displays the Progress Updates added via the ‘Update Goal Progress’ ellipsis hover 
             menu option on the Goals panel.
          • This links progress dates, keeping the original Objective details intact.

 (8/18/2023)(12.7.0.25) Tab(s) > EDITED: PopUpGoals

• Tab Name: PopUpGoals
• Tab label: Goal

• Goal Status Updates panel
          • This is a NEW panel added to the tab for display only.
          • Displays the Progress Updates added via the ‘Update Goal Progress’ ellipsis hover 
             menu option on the Goals panel.
          • This links progress dates, keeping the original Objective details intact.

 (8/22/2023)(12.7.0.25) Tab(s) > EDITED: PopUpMedMonitoring

• The Smart Function that populates the memo field was updated with the following: 
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Exam > Layouts & Tabs
          • A space is added after each sentence ending period.
          • A space is added after a comma.
          • If more than one entry with commas in a field, the last one is replaced with ‘and’.

 (8/22/2023)(12.7.0.25) Tab(s) > EDITED: PopUpTherapy

• Tab Name: PopUpTherapy
• Tab label: Therapy

• Billing Details panel
          • Ellipsis hover menu
                    • Begin Age/Name – Defaults the patient’s age and name into the Notes field.

 (8/22/2023)(12.7.0.25) Tab(s) > EDITED: See Below

• The change below was made to the following tabs:
          • Tab Name: Complaint, Tab Label: Complaint
          • Tab Name: ComplaintMH, Tab Label: Complaint
          • Tab Name: HiResCompMHNew, Tab Label: Complaint
          • Tab Name: HiResCompROSNew, Tab Label: Complaint
          • Tab Name: HiResSessNoteMH, Tab Label: Sess Note
          • Tab Name: HiResSessNotePsych, Tab Label: Psych Note

• Complaint History panel 
          • Ellipsis hover menu – Multi-Add option
                    • The Smart Functions attached that opens the windows and creates the 
                       ‘Auto compiled narrative’ memo field when done was updated.
                    • A space is added after each sentence ending period.
                    • A space is added after a comma.
                    • If more than one entry with commas in a field, the last one is replaced with 
                       ‘and’.

Exam > Orders
 (6/9/2023)(12.7.0.24) Orders > Order Details > Display Order

• The Order Detail list displays in the order of the Type of item it is. (Request) 
• If the Detail items from multiple Order Sets are displayed, they are grouped by this Type.
• Example: All Medications are grouped together and all Tests are grouped together.
• Standard sort order:
          • Diagnosis
          • Order
          • Test
          • Immunization
          • Treatment 
          • Surgery
          • Care Plan
          • Goal
          • Medication
          • Products
          • Education
          • Referral 
          • Todo Action
          • Appointment

 (8/4/2023)(12.7.0.25) Orders > Order Details > Medication

• When selecting to add a Medication, the window now includes the Sig and Qty.
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Exam > Orders
 (6/13/2023)(12.7.0.21) Orders > Order Sets > Referral

• You now have the option of adding a Referral Source to the Order Set.
• Highlight the Order Set and select Detail > Add.
• In the ‘Select Order Type’ window, double click on Referral.
• In the ‘Select Item(s)’ window, check the box to the left of the Referral Sources you want 
   to attach, then Save.

Exam > Utility
 (10/19/2023)(12.7.0.26) Utility > Order Set Auto-Build

• The NEW option ‘Order Set Auto Build’ was added.
• Once selected, click ‘Yes’ on the confirmation: Select YES to confirm the Auto-Building of 
Order Sets based upon 12 months of Previous Usage!
• When complete, click ‘OK’ on the message: Order Sets have been Created!

General
 (5/11/2023)(12.7.0.23) Display > PopUpMessages

• Messages that pop up in the software are now positioned based upon the current location 
   of the mouse on the screen. (Request) 
• This was added to reduce mouse movement and increase efficiency.

Inventory
 (10/9/2023)(12.7.0.26) All > Audit > New Audits Added

• NEW Audits were added and display on the Extended Audit Report: (Request) 
          • Inventory – Add/Edit/Delete Inventory records
          • INVENTORYSTORAGE – Changes made to the Storage area in Misc. Inventory
          • INVENTORYVENDOR – Changes made to the Vendor area in Misc. Inventory
          • Inventory Repairs and Transfers – Add/Edit/Delete Inventory Repair/Loan/Transfer 
             records
          • Inventory Adjustment – Add/Edit/Delete Inventory Adjustment records
          • ORDERS – Add/Edit/Delete Inventory Order records

 (8/8/2023)(12.7.0.25) Display > Icons

• For users that choose to display icons and not hover menus, all buttons that were moved 
   to the ellipsis hover menus are now available as icons. (Request) 
• These are only available when toggling off the Grid Hover menu by selecting ‘Grid Hover 
   Menu’ from the Printer & Output Tools icon on the bottom bar.

Ledger

Ledger > General & Display Changes
 (12.7.0.26) General > Posting Tax

• After posting an item from Inventory, if the user tries to exit the Ledger without posting 
   the Sales Tax (if applicable), the following message displays: Select OK to Post/Adjust the
   Outstanding Sales Tax Amount: xx.xx
   Exiting the Ledger will not only LOSE the Pending Tax Amount but will also Generate an 
   Audit Record that you SKIPPED the Posting of These Taxes Intentionally! (Request)
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Ledger > Charge Window
 (10/9/2023)(12.7.0.26) Charge Window > Claim Set > Hover Menu

• The ‘New’ and ‘Copy’ options on the ellipsis hover menu are grayed out once they have 
   been selected. (Request) 
• This prevents the user from creating multiple claim sets on the one charge.

 (8/11/2023)(12.7.0.25) Charge Window > Claim Set > Injections and Box 19

• When posting a J Code to the Ledger, Box 19 is automatically populated with the NDC 
   information in the Claim Set.
• If you post a different J Code and use the same Claim Set, upon saving, the following 
   message displays: Claim Set Box 19 Replaced with this J Code Info! Should you want 
   multiple J Code info in Box 19 you will need to do that manually!
• Click ‘OK’ to have the new information populate. (Request)

 (10/9/2023)(12.7.0.26) Charge Window > Transaction > Global Period

• The software now recognizes CPT Codes beginning with 3, 4 and 5 to return the ‘No 
   Global Period’ message when posting zero dollar charges. (Request)

 (8/4/2023)(12.7.0.25) Payor Notes > No Payor Attached

• When adding a Payor Note, if a Payor is not selected from the drop-down, the following 
   message displays when saving the record: Payor is Missing would you like to Continue to 
   Save? (Request)

Ledger > Commands
 (10/9/2023)(12.7.0.26) Batch > Open Existing/Re-Open > See Below:

• Enhancement was made to the Search window field for both the Open Existing and Re-
  Open commands. (Request) 
• The field length was increased and now allows the entering of symbols and spaces.

 (8/4/2023)(12.7.0.25) Credit > All Options > Apply Button

• When posting a payment in the Line Item Posting environment, the ‘Apply’ button was 
   removed from the ‘Line Item Distribution’ window.
• With the addition of the option to right click to save, this button was no longer needed.

 (8/4/2023)(12.7.0.22) Credit > Insurance > Credit Card Payment

• Some offices are receiving credit card payments from Insurance companies. (Request) 
• Post these as normal Insurance payments and in the ‘Add/Edit/Insert Insurance Payment’ 
   window, select a Desc of either ‘Credit Card’ or ‘CC Manual’.
• After selecting, you may type an abbreviated version of the Insurance name after the 
   Desc; this allows it to stand out on the Financial reports.
• Select the credit card type in the ID/CC field.

 (10/9/2023)(12.7.0.26) Service/Material/Miscellaneous/Radiology > Defaults

• The following fields default from the last Appointment the patient was in the office for: ID,
   From, To and Loc. (Request)

Look-up Tables

Look-up Tables > EHR
 (10/13/2023)(12.7.0.26) EHR > Diagnosis > Name > ICD-10

• The latest ICD-10 Codes are installed with the update to Version 12.7.0.26. (Request)
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Look-up Tables > Financial
 (6/30/2023)(12.7.0.24) Financial > Coding Rules > Wildcard Option

• When creating Coding Rules, you now have the option to use a wildcard for CPT code.
• In the CPT Code field, enter the required digits to find all CPT Codes beginning with those 
   digits.
          • Example 1: Enter 736 to find all CPT Codes beginning with ‘736’.
          • Example 2: Enter 73 to find all CPT Codes beginning with ‘73’.
• The SQL must also be updated in the remaining fields to look for the wildcard and not the 
   full code.
• Here is an example of SQL you may enter into the Units field:
          • IIF((SELECT Count (*) FROM ExamTest WHERE 
ExamUnique=:EXAMUNIQUEPARAM AND postcode LIKE '736%' AND Side ='B')>0, '2','1')
          • The wildcard: postcode LIKE ‘736%’
          • An exact match for the full code: postcode=’73620’

 (8/4/2023)(12.7.0.25) Financial > Electronic Payment > ADDED: See Below

• Password
          • Password provided by CardSmart for this Merchant ID.

• Username
          • Username provided by CardSmart for this Merchant ID.

Look-up Tables > General
 (9/6/2023)(12.7.0.25) General > Tasks > Definition > Location/Staff Group 

Assignment

• A NEW option Location/Staff Group Assignment Control was added.
• This allows the user to control which staff is assigned Tasks based upon their Location 
   and/or Staff Group. (Request) 

Here is an example of setup/functionality using just one Task and Task Group:
• Tasks > Definition Table:
          • Create Task
                    • Name: Verify Lab Results
                    • Staff Group: Back Office Staff
          • Add Detail Records
                    • Highlight the Task and select Detail > Add.
                              • Location Group – Location Group the user that prompts the addition 
                                 of the Task is associated with.
                                        • It is recommended to select either a Location Group or a Staff
                                           Group, not both.
                              • Staff Group – Staff Group the user that prompts the addition of the 
                                 Task is associated with.
                                        • It is recommended to select either a Location Group or a Staff
                                           Group, not both.
                              • Assigned Staff Group – Staff Group the Task is assigned to.
                                        • It is recommended to select either an Assigned Staff Group or
                                           an Assigned Department Group, not both.
                              • Assigned Department Group – Department Group te Task is 
                                 assigned to.
                                        • It is recommended to select either an Assigned Staff Group or
                                           an Assigned Department Group, not both.
                    • Detail Record 1: 
                              • The Staff Group selected is ‘Provider Demo’ and the Assigned Staff 
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Look-up Tables > General
                                 Group selected ‘DRD-Back Office Staff’.
                    • Detail Record 2:
                              • The Staff Group selected is ‘Provider Smith’ and the Assigned Staff 
                                 Group selected is ‘MVS-Back Office Staff’.

• Tasks > Groups Table:
          • Create a Task Group
                    • Name: Blood Work
          • Add Detail Records
                    • Highlight the Task Group and select Detail > Add.
                              • The Task selected is ‘Verify Lab Results’.

• Test > Name Table:
          • Create a Test Name, or use an existing one.
                    • Name: CBC w/o Diff w/ Plt
          • Add Detail Records
                    • Highlight the Test Name and select Detail > Add.
                              • The Task Group selected is ‘Blood Work’.

• Patient Exam:
          • Scenario 1:
                    • Log in as ‘Provider Demo’ and order the Test ‘CBC w/o Diff w/ Plt’.
                    • The Task ‘Verify Lab Results’ is added and assigned to Staff Group ‘DRD-
                       Back Office Staff’.
          • Scenario 2:
                    • Log in as ‘Provider Smith’ and order the Test ‘CBC w/o Diff w/ Plt’.
                    • The Task ‘Verify Lab Results’ is added and assigned to Staff Group ‘MVS-
                       Back Office Staff’.
          • Scenario 3:
                    • Log in as ‘Provider Jackson’ and order the Test ‘CBC w/o Diff w/ Plt’.
                    • The Task ‘Verify Lab Results’ is added and assigned to Staff Group 
                       ‘Back Office Staff’.
                    • Because ‘Provider Jackson’ is not part of the specified Staff Groups attached
                       to the Task Definition, it assigns the Task to the default Staff Group 
                       established on the Task Definition record.

Patient

Patient > General & Display Changes
 (6/13/2023)(12.7.0.24) Display Change(s) > User-Owned Tabs

• User-Owned tabs display with the tab name underlined. (Request)

Patient > Commands
 (8/4/2023)(12.7.0.25) Document > Import > File Types

When importing a document, the file types .TIF and .TIFF were added. (Request)

 (8/4/2023)(12.7.0.25) Edit > Merge > Default Date

• When merging patient accounts and prompted to enter the current date, the date field 
   defaults to the current date minus 60 days. (Request)

 (10/9/2023)(12.7.0.26) Recall > Provider ID Default
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Patient > Commands
• When adding a Recall, the ID field defaults to the Provider listed in the Demographics. 
(Request)

Printer & Output Tools
 (10/9/2023)(12.7.0.26) Workstation Configuration > Automatically Update

• You no longer have to exit the Advantage software after making a change to the 
   Workstation Configuration. (Request)

Reports

Reports > General Changes
 (8/4/2023)(12.7.0.25) General > Double Click in Parameters

• Double clicking in non-date Parameter fields no longer opens a table; use the single click 
   on the drop-down to select.
• Double click in a date field to open a calendar to select from.

 (8/11/2023)(12.7.0.25) General Changes > Full Page Default

• When the Crystal Report opens on the screen, you can click the button to maximize the 
   window.
• If you close out of that report and run another report, it automatically opens in the 
   maximized view, saving you from having to click the button.
• This maximized window stays as the default until you exit and relaunch the software. 
   (Request)

Reports > Appointment
 (6/12/2023)(12.7.0.24) Appointment > Analysis > EDITED: Statistics

• Parameter/Option changes:
          • Appt Status (sep by comma)
                    • This Parameter/Option was updated to allow for multiple Status Codes. 
                       (Request) 
                    • Codes must be separated by a comma (Example: O,R)

Reports > Electronic Health Record
 (8/4/2023)(12.7.0.25) Electronic Health Record > ADDED: 2023 PI Patient List

• This NEW report is similar to the report for 2022. (Request) 
• Prior to running the report, you must run one of the following:
          • Patient > Exam > MACRA > Quality Reporting and PI Dashboard
          • Utility > Quality Reporting and PI > Populate Report Data
• Reminder:
          • The PI Reports mirror what happened in the Quality Reporting and PI Dashboard.
          • To report on an individual clinician’s PI outcomes, you must have created a data 
             set for that individual ID in the Dashboard.

 (8/4/2023)(12.7.0.25) Electronic Health Record > ADDED: 2023 PI Simple List

• This NEW report is similar to the report for 2022. (Request) 
• Verify the Provider record has the following settings:
          • MU (PI) Participation = Y
          • MU (PI) Stage = 3
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Reports > Electronic Health Record
          • MU (PI) Year = 2023
• Prior to running the report, you must run one of the following:
          • Patient > Exam > MACRA > Quality Reporting and PI Dashboard
          • Utility > Quality Reporting and PI > Populate Report Data
• Reminder:
          • The PI Reports mirror what happened in the Quality Reporting and PI Dashboard.
          • To report on an individual clinician’s PI outcomes, you must have created a data 
             set for that individual ID in the Dashboard.

Reports > Financial
 (8/4/2023)(12.7.0.25) Financial > Acct Management > EDITED: A-R SNAPSHOT

• Parameter/Option changes:
          • View Active Accts Only? (Request) 
                    • This is a NEW Parameter/Option added.
                    • Option to exclude closed/inactive accounts.
                    • Default is ‘False’ to include both active and inactive accounts.
                    • Set to ‘True’ to exclude archived records, closed accounts and inactive 
                       patients.
                              • Archived records – Done with the Maintenance utility
                              • Closed accounts – Done from Ledger > Options > Close
                              • Inactive patients – Patient Demographic Active field NOT checked

• Report changes:
          • The ‘Page of Page’ now merges at the bottom or the report. (Request)

 (8/4/2023)(12.7.0.25) Financial > Acct Management > EDITED: A/R Responsible 
Snapshot (LIP)

• Parameter/Option changes:
          • Export View? 
                    • This is a NEW Parameter/Option added.
                    • If set to 'True', this displays a stripped down version of the report that is 
                       cleaner when exported to other programs such as Excel. 
                    • Default is ‘False’.
• Report changes:
          • If Export View? Set to ‘True’, page 1 includes instructions for export.

 (10/9/2023)(12.7.0.26) Financial > Acct Management > EDITED: Accounts 
Receivable

• Parameter/Option changes:
          • ID (Provider)
                    • Drop-down accesses the Provider table. (Request) 

• Report changes:
          • The ‘Page of Page’ now merges at the bottom or the report. (Request)

 (10/9/2023)(12.7.0.26) Financial > Acct Management > EDITED: Accts 
Receivable by Service Loc

• Report changes:
          • The ‘Page of Page’ now merges at the bottom or the report. (Request)

 (8/9/2023)(12.7.0.25) Financial > All > ADD ID (Posting Login)

• Change made to any report with the Parameter/Option to run for ADD ID (Posting Login).
• The drop-down now accesses the Login ID’s table to select from. (Request)
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Reports > Financial
 (8/11/2023)(12.7.0.25) Financial > Analysis > EDITED: RVU Analysis with 

Modifiers

• Report changes:
          • The grouping by Description was replaced with grouping by CPT Code. (Request) 
          • If there are 2 charges with the same CPT or HCPCS Code, but they have different 
             descriptions, they are grouped under the Code.

Reports > System Admin.
 (10/9/2023)(12.7.0.26) System Admin. > ADDED: Fax Status Report via Updox

• This is a NEW report. (Request) 
• The report displays the status of all faxes sent through a specified date range to Updox, 
   our electronic fax partner.
• Faxes in the report are divided into several sections: Failed, Pending, Cancelled, and 
   Completed. 
• If a section does not appear on your report, it means there were no faxes that fall under 
   that category for the selected period (or, in the case of Cancelled, it was disabled using 
   the Hide Cancelled parameter).

Utility
 (8/4/2023)(12.7.0.25) PracticeWatch Setup > Execution Order

• A NEW option ‘Execution Order’ was added to allow the user to schedule more than one 
   Task to start at the same time, while controlling the order in which they run.
• Example:
          • Schedule 2 Reports to run at 10:00 PM.
          • After saving, double click on each one to designate the Execution Order.
                    • Report A = 1 and Report B = 2
                    • Report A runs/completes, then Report B starts

 (8/9/2023)(12.7.0.25) PracticeWatch Setup > Schedule Quarterly

• When scheduling a task to run, you now have the option to select Quarterly. (Request)

Utility > Miscellaneous Utilities
 (10/9/2023)(12.7.0.26) Miscellaneous Utilities > Other Utilities > Moved to 

Utility SQL Scripts

• Options previously found under Other Utilities were moved to Utility > System 
   Administrator > Dictionary Utilities > Utility SQL Scripts.

Utility > System Administrator
 (8/4/2023)(12.7.0.25) System Administrator > Dictionary Utilities > Re-

Index/Recalculate in Bulk > All Users Out

• All users MUST be out of the software to run this utility.
• Unlike previous versions, you no longer have to stop services such as PracticeWatch, HL-7
   APR, FHIR.
• The following warning message displays upon accessing the utility and you must select 
   either ‘Yes’ or ‘No’:
Bulk ReIndex/ReCalc Operation Requires ALL USERS out of Software!
This operation should ONLY BE USED IN EXTREME CASES where a backup is not available 
and, due to file corruption, a Complete ReIndex/ReCalculation is necessary.
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Utility > System Administrator
Is this one of those EXTREME CASES?

 (8/4/2023)(12.7.0.25) System Administrator > Dictionary Utilities > Re-
Index/Recalculate in Bulk > Changes

• The ‘Options’ command was removed as data is accessed from the Level drop-down.
• The ‘Index Only’ field was removed as all Levels are now run as full (as if Index Only was 
   not checked).
          • To run ReIndexing, select the Utility ReIndex Individual Table.
• The Level of ‘Complete’ was changed to ‘ReIndex All Tables/Rebuild Dictionary
• The Level of ‘Ledger Related ONLY’ was replaced with ‘ReCalc All (ledger, Inventory, AP, 
   etc)’ and includes the following:
          • Indexing TABLEDEFINITION Database 
          • Indexing INDEX Database 
          • Indexing TMASTER Database 
          • ReCalculating Ledger 
          • Checking Table Unique Values 
          • Checking Balance & Invoices for all Payable Accounts 
          • Checking Accuracy of Outstanding Orders 
          • Outstanding Order Fix Count: 
          • Verifying each patient has an account 
          • Verifying each Account has correct # of patients 
          • ReIndexing/ReCalculate Completed

 (8/4/2023)(12.7.0.25) System Administrator > Dictionary Utilities > Re-
Index/Recalculate in Bulk > PracticeWatch

• Every Sunday, PracticeWatch runs an algorithm based on how often the tables are used.
• The ReIndex/ReCalculate in Bulk is run on 30 of these files each week. (Request) 
• As users delete records and add new ones, the size of the index files increase.
• Running the ReIndex/ReCalculate utility rebuilds the index, puts everything in order and 
   removes deleted records, therefor providing a smaller index file.
• The smaller file is easier to access and manage by the operating system and Advantage 
   Database Server and results in peak performance.

 (10/9/2023)(12.7.0.26) System Administrator > Dictionary Utilities > Utility SQL 
Scripts > ADDED: See Below

• Entries are now alphabetically sorted by Name. (Request) 

• NEW SQL Script ‘EDI: Cleanup Old Insurance Billed and Paid Dates’ was added. (Request) 
          • This was moved from Other Utilities and renamed from: Clean-up Billed Dates.

• NEW SQL Script ‘Provider ID Change’ was added (Request) 
          • This was moved from Other Utilities and renamed from: Change Provider ID.

 (10/9/2023)(12.7.0.26) System Administrator > Login > IDs > Role

• The label for ‘Role’ was changed to ‘Primary Role’. (Request) 
• This was done in preparation for the NEW Detail option to connect Additional Roles.
• This portion is still in development.

 (10/9/2023)(12.7.0.26) System Administrator > Login > Profiles > Rights > 
Added: See Below

• The NEW Right ‘PHI Patient/EHR Audits’ was added for future development.

 (8/9/2023)(12.7.0.24) System Administrator > System Setup/Configuration > 
ADDED: Audit History
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Utility > System Administrator
• The NEW configuration utility ‘Audit History’ was added to show a history of changes 
   made under the System Setup/Configuration area. (Request) 
• Information displayed:
          • When – Date and time change was made
          • Who – Name of the person logged in when the change was made
          • Table – Table name where action was taken; Example: MASTER. (Request) 
          • Action – Action that was taken, such as ‘Edit’
• Double click on a line to display the audit field by field changes.
          • Displays field name and information before and after the change.

Worklists
 (9/6/2023)(12.7.0.25) Global > EDITED: Claim Edit Errors Worklists

• Double click on a record in the Worklist to open a window to allow full view of the error 
   for ease of correcting issues. (Request)

 (8/16/2023)(12.7.0.25) Global > EDITED: RCM: Insurance Follow Up

• The Worklist now ignores any item with a follow up date in the future. (Request)

 (8/18/2023)(12.7.0.25) Global > REMOVED: ABB Catalog Lookup Failure

• The Worklist ‘ABB Catalog Lookup Failure’ was removed as is it no longer needed.

 (7/6/2023)(12.6.0.16) Global > ADDED: Denial Claims

• Allows the user to see all denied claims (sent electronically) and work them directly from 
   the Worklist.

I.T. Specialist Information
 (8/24/2023)(12.7.0.25) Auto Diagnostics > Function Change

• The option to set up Auto Diagnostics was removed for Cloud-based clients, as 
   PracticeWatch now automatically runs the ReIndex/ReCalculate in Bulk on selected files 
   every Sunday.
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